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Introduction

The old 80/20 rule for software—that 80 percent of a program’s users use only  
20 percent of a program’s features—doesn’t apply to Microsoft Excel. Instead, 

this program probably operates under what could be called the 95/5 rule: Ninety-five 
percent of Excel users use a mere 5% of the program’s power. On the other hand, most 
people know that they could be getting more out of Excel if they could only get a leg 
up on building formulas and using functions. Unfortunately, this side of Excel appears 
complex and intimidating to the uninitiated, shrouded as it is in the mysteries of 
mathematics, finance, and impenetrable spreadsheet jargon.

If this sounds like the situation you find yourself in, and if you’re a businessperson 
who needs to use Excel as an everyday part of your job, you’ve come to the right book. In 
Microsoft Excel Formulas and Functions (Office 2021 and Microsoft 365), I demystify the 
building of worksheet formulas and present the most useful of Excel’s many functions in 
an accessible, jargon-free way. This book not only takes you through Excel’s intermediate 
and advanced formula-building features, but it also tells you why these features are use-
ful to you and shows you how to use them in everyday situations and real-world models. 
This book does all this with no-nonsense, step-by-step tutorials and lots of practical, 
useful examples aimed directly at business users.

Even if you’ve never been able to get Excel to do much beyond storing data and 
adding a couple of numbers, you’ll find this book to your liking. I show you how to build 
useful, powerful formulas from the ground up, so no experience with Excel formulas and 
functions is necessary.

What’s in the book

This book isn’t meant to be read from cover to cover, although you’re certainly free to 
do just that if the mood strikes you. Instead, most of the chapters are set up as self-
contained units that you can dip into at will to extract whatever nuggets of information 
you need. However, if you’re relatively new to Excel formulas and functions, I suggest 
starting with Chapter 1, “Building basic formulas,” and Chapter 4, “Understanding 
functions,” to ensure that you have a thorough grounding in the fundamentals.

The book is divided into four main parts. To give you the big picture before diving in, 
here’s a summary of what you’ll find in each part:

■■ Part I, “Mastering Excel formulas”—The three chapters in Part I tell you just 
about everything you need to know about building formulas in Excel. This part 
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discusses operators, expressions, advanced formula features, and formula-
troubleshooting techniques.

■■ Part II, “Harnessing the power of functions”—Functions take your formulas 
to the next level, and you learn all about them in Part II. After you see how to use 
functions in your formulas, you examine seven main function categories—text, 
logical, information, lookup, date, time, and math. In each case, I tell you how to 
use the functions and give you lots of practical examples that show you how you 
can use the functions in everyday business situations.

■■ Part III, “Building business formulas”—This part is crammed with business 
goodies related to performing financial wizardry with Excel. You learn how to 
implement many standard business formulas in Excel, and you get in-depth looks 
at Excel’s descriptive and inferential statistical tools, powerful regression-analysis 
techniques to track trends and make forecasts, and techniques and functions for 
amortizing loans, analyzing investments, and using discounting for business-case 
and cash-flow analysis.

■■ Part IV, “Building business models”—The four chapters in Part IV are all 
business, as they examine various facets of building useful and robust business 
models. You learn how to analyze data with Excel tables and PivotTables, how to 
use what-if analysis and Excel’s Goal Seek and scenarios features, and how to use 
the amazing Solver feature to solve complex problems.

This book’s special features

Microsoft Excel Formulas and Functions (Office 2021 and Microsoft 365) is designed 
to give you the information you need without making you wade through ponderous 
explanations and interminable technical background. To make your life easier, this book 
includes various features and conventions that help you get the most out of the book 
and Excel itself:

■■ Steps: Throughout the book, each Excel task is summarized in step-by-step 
procedures.

■■ Things you type: Whenever I suggest that you type something, what you type 
appears in a bold font.

■■ Commands: I use the following style for Excel menu commands: File > Open. 
This means that you pull down the File menu and select the Open command.

■■ Dialog box controls: The names of dialog box controls and other onscreen 
elements appear in bold text: Select the OK button.
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■■ Functions: Excel worksheet functions appear in capital letters: SUM. When I list 
the arguments you can use with a function, they appear in italic to indicate that 
they’re placeholders you replace with actual values; also, optional arguments 
appear surrounded by square brackets: CELL(info_type [, reference]).

This book also uses the following boxes to draw your attention to important (or 
merely interesting) information.

 

Note  The Note box presents asides that offer more information about the 
topic under discussion. These tidbits provide extra insights that give you a bet-
ter understanding of the task at hand.

Tip  The Tip box tells you about Excel methods that are easier, faster, or more 
efficient than the standard methods.

Caution  The all-important Caution box tells you about potential accidents 
waiting to happen. There are always ways to mess things up when you’re work-
ing with computers. These boxes help you avoid at least some of the pitfalls.

About the companion content

To make it easier for you to learn Excel formulas and functions, all the sample content 
used in the book is available online. To download the sample workbooks, look for the 
download link on the book’s page:

MicrosoftPressStore.com/Excel365FormulasFunctions/downloads 

Alternatively, visit the book’s page at paulmcfedries.com and click the Examples.zip 
link to download the files:

https://paulmcfedries.com/books/book.php?title=excel-365-formulas-and-functions

Support and feedback

The following sections provide information on errata, book support, feedback, and 
contact information.
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Errata, updates, and book support
We’ve made every effort to ensure the accuracy of this book and its companion content. 
You can access updates to this book—in the form of a list of submitted errata and their 
related corrections—at the following page:

MicrosoftPressStore.com/Excel365FormulasFunctions/errata

If you discover an error that is not already listed, please submit it to us at the same 
page.

For additional book support and information, please visit MicrosoftPressStore.com/
Support.

Please note that product support for Microsoft software and hardware is not offered 
through the previous addresses. For help with Microsoft software or hardware, go to 
http://support.microsoft.com.

Stay in touch
Let’s keep the conversation going! We’re on Twitter:

http://twitter.com/MicrosoftPress
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C H A P T E R  3

Troubleshooting formulas

In this chapter, you will:

■■ Decipher the formula error values that Excel displays

■■ Learn how to fix a few other common formula error types

■■ Handle formula errors gracefully with the IFERROR function

■■ Diagnose formula problems using Excel’s Formula Error Checker

■■ Learn how to use Excel’s worksheet auditing tools

Despite your best efforts, the odd error might appear in your formulas from time to time. Such errors 
can be mathematical (for example, dividing by zero), or Excel might simply be incapable of interpreting 
the formula. In the latter case, problems can be caught while you’re entering the formula. For example, 
if you try to enter a formula that has unbalanced parentheses, Excel doesn’t accept the entry, and it dis-
plays an error message. Other errors are more insidious. For example, your formula might appear to be 
working—that is, it might return a value—but the result might be incorrect because the data is flawed 
or because your formula has referenced the wrong cell or range.

Whatever the error and cause, formula woes need to be worked out because you or someone else in 
your company likely depends on your models to produce accurate results. Don’t fall into the trap  
of thinking that your spreadsheets are problem-free. A recent University of Hawaii study found that  
50 percent of spreadsheets contained errors that led to “significant miscalculations.” And the more 
complex the model, the greater the chance that errors can creep in. A KPMG study from a few years 
ago found that a staggering 90 percent of spreadsheets used for tax calculations contained errors.

The good news is that fixing formula flaws need not be drudgery. With a bit of know-how and 
Excel’s top-notch troubleshooting tools, sniffing out and repairing model maladies isn’t hard. This 
chapter tells you everything you need to know.

 

Tip  If you try to enter an incorrect formula, Excel won’t let you do anything else until you 
either fix the problem or cancel the operation (which means you lose your formula). If the 
formula is complex, you might not be able to see the problem right away. Instead of delet-
ing all your work, place an apostrophe (') at the beginning of the formula to convert it to 
text. This way, you can save your work while you try to figure out the problem.

9780137559404_print.indb   51 19/01/22   5:58 PM



52	 Chapter 3  Troubleshooting formulas

Understanding Excel’s error values

When you enter or edit a formula or change one of the formula’s input values, Excel might show an 
error value as the formula result. Excel has eleven different error values: #CALC!, #DIV/0!, #FIELD!, 
#N/A, #NAME?, #NULL!, #NUM!, #REF!, #SPILL!, #UNKNOWN!, and #VALUE!. The next few sections give you a 
detailed look at these error values and offer suggestions for dealing with them.

#CALC!
The new #CALC! error appears when Excel’s calculation engine comes across a formula or expression 
that it doesn’t support. Examples include one of the following:

■■ An array nested inside another array

■■ An array that includes one or more range references

■■ An array that contains no items

#DIV/0!
The #DIV/0! error almost always means that the cell’s formula is trying to divide by zero, a math-
ematical no-no. The cause is usually a reference to a cell that either is blank or contains the value 
0. Check the cell’s precedents (the cells that are directly or indirectly referenced in the formula; see 
“Auditing a worksheet,” later in this chapter) to look for possible culprits. You’ll also see #DIV/0! if you 
enter an inappropriate argument in some functions. MOD, for example, returns #DIV/0! if the second 
argument is 0.

That Excel treats blank cells as the value 0 can pose problems in a worksheet that requires the 
user to fill in the data. If your formula requires division by one of the temporarily blank cells, it will 
show #DIV/0! as the result, possibly confusing the user. You can get around this by telling Excel not 
to perform the calculation if the cell used as the divisor is 0. This is done with the IF worksheet func-
tion, which I discuss in detail in Chapter 6, “Working with logical and information functions.” (For an 
even better way to deal with potential formula errors, see “Handling formula errors with IFERROR,” 
later in this chapter.) For example, consider the following formula, which uses named cells to calculate 
gross margin:

=GrossProfit / Sales

To prevent the #DIV/0! error from appearing if the Sales cell is blank (or 0), you’d modify the 
formula as follows:

=IF(Sales = 0, "", GrossProfit / Sales)

If the value of the Sales cell is 0, the formula returns the empty string; otherwise, it performs the 
calculation.
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#FIELD!
The #FIELD! error value tells you that your formula is referencing an invalid linked data type. This can 
happen in three ways:

■■ Your formula includes a data-type reference to a field that isn’t found in a linked data type. For 
example, if cell A1 contains a Stocks data type and your formula references A1.[52-week high], 
you’ll get a #FIELD! error because the 52-week high field doesn’t exist. In this example, you can 
solve the problem by removing the dash: A1.[52 week high].

■■ Your formula includes a data-type reference (for example, A1.Price for a Stocks data type) to a 
cell that doesn’t use a linked data type.

■■ Your formula includes a data-type reference (for example, A1.Description for a Stocks data 
type) to a cell that doesn’t have any data for the referenced field.

#N/A
The #N/A error value is short for not available, and it means that the formula couldn’t return a legitimate 
result. You usually see #N/A when you use an inappropriate argument (or when you omit a required 
argument) in a function. HLOOKUP and VLOOKUP, for example (see Chapter 7, “Working with lookup func-
tions”), return #N/A if the lookup value is smaller than the first value in the lookup range.

To solve the problem, first check the formula’s input cells to see whether any of them are displaying 
the #N/A error. If so, that’s why your formula is returning the same error; the problem actually lies in the 
input cell. When you’ve found where the error originates, examine the formula’s operands to look for 
inappropriate data types. In particular, check the arguments used in each function to ensure that they 
make sense for the function and that no required arguments are missing.

 

Note  It’s common in spreadsheet work to purposely generate an #N/A! error to show that 
a particular cell value isn’t currently available. For example, you might be waiting for budget 
figures from one or more divisions or for the final numbers from month- or year-end. In 
such a case, you enter =NA() into the cell. You fix this “problem” by replacing the NA function 
with the appropriate data when it arrives.

#NAME?
The #NAME? error appears when Excel doesn’t recognize a name you used in a formula or when it inter-
prets text within the formula as an undefined name. This means that the #NAME? error pops up in a wide 
variety of circumstances:

■■ You spelled a range name incorrectly.

■■ You used a range name that you haven’t yet defined.

■■ You spelled a function name incorrectly.
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■■ You used a function that’s part of an uninstalled add-in.

■■ You used a string value without surrounding it with quotation marks.

■■ You entered a range reference and accidentally omitted the colon.

■■ You entered a reference to a range on another worksheet and didn’t enclose the sheet name in 
single quotation marks.

 

Tip  When entering function names and defined names, use all lowercase letters. If Excel 
recognizes a name, it converts the function to all uppercase and the defined name to its 
original case. If no conversion occurs, you know that you misspelled the name, you haven’t 
defined it yet, or you’re using a function from an add-in that isn’t loaded.

Remember that you also can use these commands to enter functions and names safely: 

■■ Formulas > Insert Function (or press Shift+F3)

■■ Formulas > Use In Formula

■■ Formulas > Use In Formula > Paste Names (or press F3)

These are mostly syntax errors, so fixing them means double-checking your formula and correct-
ing range name or function name misspellings or inserting missing quotation marks or colons. Also, 
be sure to define any range names you use and to install the appropriate add-in modules for functions 
you use.

Avoiding #NAME? errors when deleting range names
If you’ve used a range name in a formula and then you delete that name, Excel generates the #NAME? 
error. Wouldn’t it be better if Excel just converted the name to its appropriate cell reference in each 
formula? Possibly, but there is an advantage to Excel’s seemingly inconvenient approach. By generating 
an error, Excel enables you to catch range names that you delete by accident. Because Excel leaves the 
names in the formula, you can recover by redefining the original range name.

Redefining the original range name becomes problematic if you can’t remember the appropriate 
range coordinates. This is why it’s always a good idea to paste a list of range names and their references 
into each of your workbooks (select Formulas > Use In Formula > Paste Names > Paste List).

If you don’t need this safety net, you can force Excel to convert deleted range names into their cell 
references. Here are the steps to follow:

	 1.	 Select File > Options to display the Excel Options dialog box.

	 2.	 Select Advanced.
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	 3.	 In the Lotus Compatibility Settings For section, use the list to select the worksheet you want 
to use.

	 4.	 Select the Transition Formula Entry check box.

	 5.	 Select OK.

Excel now treats your formula entries the same way Lotus 1-2-3 did way back in days of yore. Specifi-
cally, in formulas that use a deleted range name, the name automatically gets converted to its appro-
priate range reference. As an added bonus, Excel also performs the following automatic conversions:

■■ If you enter a range reference in a formula, the reference gets converted to a range name  
(provided that a name exists, of course).

■■ If you define a name for a range, Excel converts any existing range references into the new 
name.

Caution  The treatment of formulas in the Lotus 1-2-3 manner only applies to formulas that 
you create after you select the Transition Formula Entry check box.

#NULL!
Excel displays the #NULL! error in a very specific case: when you use the intersection operator (a space) 
on two ranges that have no cells in common. For example, because the ranges A1:B2 and C3:D4 have no 
common cells, the following formula returns the #NULL! error:

=SUM(A1:B2 C3:D4)

Check your range coordinates to ensure that they’re accurate. Also, check to see if one of the ranges 
has been moved, causing the two ranges in your formula to no longer intersect.

#NUM!
The #NUM! error means there’s a problem with a number in a formula. This almost always means that 
you entered an invalid argument in a math or trig function. For example, perhaps you entered a nega-
tive number as the argument for the SQRT or LOG function. Check the formula’s input cells—particularly 
those that are used as arguments for mathematical functions—to make sure the values are appropriate.

The #NUM! error also appears if you’re using iteration (or a function that uses iteration; see Chapter 2, 
“Creating advanced formulas”), and Excel can’t calculate a result. There could be no solution to the 
problem, or you might need to adjust the iteration parameters.
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#REF!
The #REF! error means that a formula contains an invalid cell reference, which is usually caused by one 
of the following actions:

■■ You deleted a cell to which the formula refers. You need to add the cell back in or adjust the 
formula reference.

■■ You cut a cell and then pasted it into a cell used by the formula. You need to undo the cut and 
then paste the cell elsewhere. (Note that it’s okay to copy a cell and paste it onto a cell used by 
the formula.)

■■ Your formula references a nonexistent cell address, such as B0. This can happen if you cut 
or copy a formula that uses relative references and paste it in such a way that the invalid cell 
address is created. For example, suppose that your formula references cell B1. If you cut or copy 
the cell containing the formula and paste it one row higher, the reference to B1 becomes invalid 
because Excel can’t move the cell reference up one row.

#SPILL!
You see the #SPILL! error when a dynamic array formula or function that needs to spill data into one or 
more adjacent cells encounters a non-empty cell in the spill range. (See Chapter 2 to learn more about 
spill ranges.) You have two ways to handle a #SPILL! error:

■■ Move the formula that needs the spill range to a new location where the spill range is empty.

■■ Move the existing data out of the spill range.

In both cases, Excel removes the #SPILL! error and spills the formula result in the new spill range.

#UNKNOWN!
If you see the #UNKNOWN! error, it means your formula or expression is referencing a data type that isn’t 
supported in your version of Excel. This most often means that the reference is to a data type that was 
added to a later version of Excel, so the only way to resolve the error is to upgrade to a version of Excel 
that supports the data type.

#VALUE!
When Excel generates a #VALUE! error, it means you’ve used an inappropriate argument in a func-
tion. This is most often caused by using the wrong data type. For example, you might have entered or 
referenced a string value instead of a numeric value. Similarly, you might have used a range reference 
in a function argument that requires a single cell or value. Excel also generates this error if you use a 
value that’s larger or smaller than Excel can handle. In all these cases, you solve the problem by double-
checking your function arguments to find and edit the inappropriate arguments.
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Note  Excel can work with values between –1E–307 and 1E+307.

Fixing other formula errors

Not all formula errors generate one of Excel’s 11 error values. Instead, you might see a warning dialog 
box from Excel (for example, if you try to enter a function without including a required argument). Or, 
you might not see any indication that something is wrong. To help you in these situations, the following 
sections cover some of the most common formula errors.

Missing or mismatched parentheses
If you miss a parenthesis when typing a formula or place a parenthesis in the wrong location, Excel 
usually displays a dialog box like the one shown in Figure 3-1 when you attempt to confirm the formula. 
If the edited formula is what you want, select Yes to have Excel enter the corrected formula automati-
cally; if the edited formula is incorrect, select No and edit the formula by hand.

 

Note  You can work with all the examples in this chapter by downloading Chapter03.xslx 
from either of the companion content sites mentioned in the Introduction.

FIGURE 3-1  If you miss a parenthesis, Excel attempts to fix the problem and displays this dialog box to ask if you 
want to accept the correction.

Caution  Excel doesn’t always fix missing parentheses correctly. It tends to add the missing 
parenthesis to the end of the formula, which is often not what you want. Therefore, always 
check Excel’s proposed solution carefully before accepting it.
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To help you avoid missing or mismatched parentheses, Excel provides two visual clues in the formula 
itself when you’re editing it:

■■ The first clue occurs when you type a close parenthesis character—). Excel temporarily bolds 
both the close parenthesis and its corresponding open parenthesis—(. If you type what you 
think is the last close parenthesis, but Excel doesn’t bold the first open parenthesis, your paren-
theses are unbalanced.

■■ The second clue occurs when you use the left and right arrow keys to navigate a formula. When 
you cross over a parenthesis, Excel bolds the other parenthesis in the pair.

Erroneous formula results
If a formula produces no warnings or error values, the result might still be in error. If the result of a for-
mula is incorrect, here are a few techniques that can help you understand and fix the problem:

■■ Calculate complex formulas one term at a time. In the formula bar, select the expression 
you want to calculate and then press F9. Excel converts the expression into its value. Make sure 
that you press the Esc key when you’re done to avoid entering the formula with just the calcu-
lated values.

■■ Evaluate the formula. You can step through the various parts of a formula, a technique that I 
describe later in this chapter (see “Evaluating formulas”).

■■ Break up long or complex formulas. One of the most problematic aspects of formula 
troubleshooting is making sense out of long formulas. The previous techniques can help (by 
enabling you to evaluate parts of the formula), but it’s usually best to keep your formulas as 
short as you can at first. When you get things working properly, you can often combine formu-
las for a more efficient model.

■■ Recalculate all formulas. A formula might display the wrong result because other formulas on 
which it depends need to be recalculated. This is particularly true if one or more of those formu-
las use custom VBA functions. Select Shift+F9 to recalculate all worksheet formulas.

■■ Pay attention to operator precedence. As explained in Chapter 1, “Building basic formulas,” 
Excel’s operator precedence means that certain operations are performed before others. An 
erroneous formula result could, therefore, be caused by Excel’s precedence order. To control 
precedence, use parentheses.

■■ Watch out for nonblank “blank” cells. A cell might appear to be blank but actually contain 
data or even a formula. For example, some users “clear” a cell by selecting the spacebar, and 
Excel then treats the cell as nonblank. Similarly, some formulas return an empty string instead 
of a value. (For example, see the IF function formula earlier in this chapter for avoiding the 
#DIV/0! error.)
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■■ Watch unseen values. In a large model, your formula could be using cells that you can’t see 
because they’re offscreen or on another sheet. Excel’s Watch Window enables you to keep an 
eye on the current value of one or more cells. To learn about the Watch Window, see “Watching 
cell values,” later in this chapter.

Fixing circular references
A circular reference occurs when a formula refers to its own cell. This can happen in one of two ways:

■■ Directly: The formula explicitly references its own cell. For example, a circular reference would 
result if the following formula were entered into cell A1:

=A1+A2

■■ Indirectly: The formula references a cell or function that, in turn, references the formula’s cell. 
For example, suppose that cell A1 contains the following formula:

=A5*10

■■ A circular reference would result if cell A5 referred to cell A1, as in this example:

=SUM(A1:D1)

When Excel detects a circular reference, it displays the dialog box shown in Figure 3-2. Here’s the 
formula in cell B3:

=B1 / (1 + B2)

Here’s the formula in cell B1:

=B3 *  (1 + B2)

These formulas refer to each other’s cells, creating a circular reference.

FIGURE 3-2  If you attempt to enter a formula that contains a circular reference, Excel displays this dialog box.

When you select OK, Excel displays tracer arrows that connect the cells involved in the circular refer-
ence. (Tracers are discussed in detail later in this chapter; see “Auditing a worksheet.”) Knowing which 
cells are involved enables you to correct the formula in one of them to solve the problem.
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Handling formula errors with IFERROR

Earlier, you saw how to use the IF function to avoid a #DIV/0! error by testing the value of the for-
mula divisor to see if it equals 0. This works fine if you can anticipate the specific type of error the user 
might make. However, in many instances, you can’t know the exact nature of the error in advance. For 
example, the simple formula =GrossProfit/Sales would generate a #DIV/0! error if Sales equals 0. 
However, it would generate a #NAME? error if the name GrossProfit or the name Sales no longer exists, 
or it would generate a #REF! error if the cells associated with one or both of GrossProfit and Sales 
were deleted.

If you want to handle errors gracefully in your worksheets, it’s often best to assume that any error 
can occur. Fortunately, that doesn’t mean you have to construct complex tests using deeply nested IF 
functions that check for every error type (#DIV/0!, #N/A, and so on). Instead, Excel enables you to use a 
simple test for any error by offering the IFERROR function:

IFERROR(value, value_if_error)

value The expression that might generate an error

value_if_error The value to return if value returns an error

If the value expression doesn’t generate an error, IFERROR returns the expression result; otherwise, it 
returns value_if_error (which might be the null string or an error message). Here’s an example:

=IFERROR(GrossProfit / Sales, "")

 

Note  If you want to handle the specific case of the #N/A error, use the IFNA(value, value_
if_na) function. Here, value is the expression that you’re testing for the #N/A error, and 
value_if_na is the value to return if value returns the #N/A error.

Using the formula error checker

If you use Microsoft Word, you’re probably familiar with the double blue line that appears under words 
and phrases that the grammar checker has flagged as being incorrect. The grammar checker operates 
by using a set of rules that determines correct grammar and syntax. As you type, the grammar checker 
operates in the background, constantly monitoring your writing. If something you write goes against 
one of the grammar checker’s rules, the wavy line appears to let you know there’s a problem.

Excel has a similar feature: the formula error checker. Like the grammar checker, the formula error 
checker uses a set of rules to determine correctness, and it operates in the background to monitor your 
formulas. If it detects something amiss, it displays an error indicator—a green triangle—in the upper-
left corner of the cell containing the formula, as shown in Figure 3-3.
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Error indicator

FIGURE 3-3  If Excel’s formula error checker detects a problem, it displays a green triangle in the upper-left corner 
of the formula’s cell.

Choosing an error action
When you select the cell with the formula error, Excel displays a formula error icon beside the cell. 
If you hover your mouse pointer over the icon, a pop-up message describes the error, as shown in 
Figure 3-4. The formula error icon drop-down menu contains the following actions:

■■ Corrective Action: This is a command (the name of which depends on the type of error) that 
Excel believes either will fix the problem or help you troubleshoot the error. For example, in 
Figure 3-4, Excel is reporting that the formula in cell C3 differs from its neighboring formulas. 
(In the formula bar, the expression in the parentheses should be 1+C2 instead of 1-C2.) In this 
case, the corrective action command in the formula error icon is Copy Formula From Left. Or, 
if Excel can’t suggest a solution, it might show the command Show Calculation Steps, which runs 
the Evaluate Formula feature. See “Evaluating formulas,” later in this chapter.

■■ Help On This Error: Select this option to get information on the error via the Excel Help 
system.

■■ Ignore Error: Select this option to leave the formula as is.

■■ Edit In Formula Bar: Select this option to display the formula in Edit mode in the formula bar. 
You can then fix the problem by editing the formula.

■■ Error-Checking Options: Select this option to display the Formulas tab of the Excel Options 
dialog box (discussed next).

FIGURE 3-4  Select the cell containing the error and then move the mouse pointer over the formula error icon to 
see a description of the error.
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Setting error checker options
Like Word’s grammar checker, Excel’s formula error checker has a number of options that control how it 
works and which errors it flags. To see these options, you have two choices:

■■ Select File > Options > Formulas to open the Excel Options dialog box and display the 
Formulas tab.

■■ Select Error-Checking Options in the formula error icon’s drop-down menu (as described in 
the previous section).

Either way, the options appear in the Error Checking and Error Checking Rules sections in the 
Formulas tab, as shown in Figure 3-5.

FIGURE 3-5  In the Formulas tab, the Error Checking and Error Checking Rules sections contain the options that 
govern the workings of the formula error checker.

Here’s a rundown of the available options:

■■ Enable Background Error Checking: This check box toggles the formula error checker’s back-
ground operation on and off. If you turn off the background checking, you can run a check at 
any time by choosing Formulas > Error Checking.

■■ Indicate Errors Using This Color: Use this color palette to select the color of the error indicator.

■■ Reset Ignored Errors: If you’ve ignored one or more errors, you can redisplay the error indica-
tors by selecting this button.

■■ Cells Containing Formulas That Result In An Error: When this check box is selected, the 
formula error checker flags formulas that evaluate to #DIV/0!, #NAME?, or any of the other error 
values discussed earlier.

■■ Inconsistent Calculated Column Formula In Tables: When this check box is selected, Excel 
examines the formulas in a table’s calculated column and flags any cell that contains a formula 
with a different structure than the other cells in the column. The formula error icon for this error 
includes the command Restore To Calculated Column Formula, which enables you to update 
the formula so that it’s consistent with the rest of the column.
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■■ Cells Containing Years Represented As 2 Digits: When this check box is selected, the for-
mula error checker flags formulas that contain date text strings in which the year contains only 
two digits (a possibly ambiguous situation because the string could refer to a date in either the 
1900s or the 2000s). In such a case, the list of options supplied in the formula error icon contains 
two commands—Convert XX To 19XX and Convert XX To 20XX—that enable you to convert 
the two-digit year to a four-digit year.

■■ Numbers Formatted As Text Or Preceded By An Apostrophe: When this check box is 
selected, the formula error checker flags cells that contain a number that is either formatted as 
text or preceded by an apostrophe. In such a case, the list of options supplied in the formula error 
icon contains the Convert To Number command to convert the text to its numeric equivalent.

■■ Formulas Inconsistent With Other Formulas In The Region: When this check box is 
selected, the formula error checker flags formulas that are structured differently from similar 
formulas in the surrounding area. In such a case, the list of options supplied in the formula error 
icon contains a command such as Copy Formula From Left to make the formula consistent 
with the surrounding cells.

■■ Formulas Which Omit Cells In A Region: When this check box is selected, the formula error 
checker flags formulas that omit cells that are adjacent to a range referenced in the formula. For 
example, suppose that the formula is =AVERAGE(C4:C21), where C4:C21 is a range of numeric 
values. If cell C3 also contains a numeric value, the formula error checker flags the formula to 
alert you to the possibility that you missed including cell C3 in the formula. Figure 3-6 shows 
this example. In such a case, the list of options supplied in the formula error icon will contain the 
command Update Formula To Include Cells to adjust the formula automatically.

FIGURE 3-6  The formula error checker can flag formulas that omit cells that are adjacent to a range referenced by 
the formula. In this case, the formula in C23 should include cell C3.
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■■ Unlocked Cells Containing Formulas: When this check box is selected, the formula error 
checker flags formulas that reside in unlocked cells. This isn’t an error so much as a warning that 
other people could tamper with the formula even after you have protected the sheet. In such a 
case, the list of options supplied in the formula error icon will contain the command Lock Cell 
to lock the cell and prevent users from changing the formula after you protect the sheet.

■■ Formulas Referring To Empty Cells: When this check box is selected, the formula error 
checker flags formulas that reference empty cells. In such a case, the list of options supplied in 
the formula error icon will contain the command Trace Empty Cell to enable you to find the 
empty cell. (At this point, you can either enter data into the cell or adjust the formula so that it 
doesn’t reference the cell.)

■■ Data Entered In A Table Is Invalid: When this check box is selected, the formula error checker 
flags cells that violate a table’s data-validation rules. This can happen if you set up a data-
validation rule with only a Warning or Information style, in which case the user can still opt to 
enter the invalid data. In such cases, the formula error checker will flag the cells that contain 
invalid data. The formula error icon list includes the Display Type Information command, 
which shows the data-validation rule that the cell data violates.

■■ Misleading Number Formats: When this check box is selected, the formula error checker flags 
cells that have a numeric, date, or time format that Excel deems incompatible with the formula 
result. For example, Excel displays this error if a formula applies a mathematical operation to a 
currency value, but the formula’s cell is formatted as a date or time. The formula error icon list 
includes the Update Format command, which changes the cell data format to fit the formula 
result.

Auditing a worksheet

As you’ve seen, some formula errors result from referencing other cells that contain errors or inappro-
priate values. The first step in troubleshooting these formula problems is to determine which cell (or 
group of cells) is causing an error. This is straightforward if the formula references only a single cell, but 
it gets progressively more difficult as the number of references increases. (Another complicating factor 
is the use of range names because it won’t be obvious which range each name is referencing.)

To determine which cells are wreaking havoc on your formulas, you can use Excel’s auditing features 
to visualize and trace a formula’s input values and error sources.

Understanding auditing
Excel’s formula-auditing features operate by creating tracers—arrows that literally point out the cells 
involved in a formula. You can use tracers to find three kinds of cells:

■■ Precedents: These are cells that are directly or indirectly referenced in a formula. For example, 
suppose that cell B4 contains the formula =B2; then B2 is a direct precedent of B4. Now suppose 

9780137559404_print.indb   64 19/01/22   5:58 PM



	 Chapter 3  Troubleshooting formulas	 65

that cell B2 contains the formula =A2/2; this makes A2 a direct precedent of B2, but it’s also an 
indirect precedent of cell B4.

■■ Dependents: These are cells that are directly or indirectly referenced by a formula in another 
cell. In the preceding example, cell B2 is a direct dependent of A2, and B4 is an indirect 
dependent of A2.

■■ Errors: These are cells that contain an error value and are directly or indirectly referenced in a 
formula (and therefore cause the same error to appear in the formula).

Figure 3-7 shows a worksheet with three examples of tracer arrows:

■■ Cell B4 contains the formula =B2, and B2 contains =A2/2. The arrows (they’re blue onscreen) 
point out the precedents (direct and indirect) of B4.

■■ Cell D4 contains the formula =D2, and D2 contains =D1/0. The latter produces the #DIV/0! error. 
Therefore, the same error appears in cell D4. The arrow (it’s red onscreen) is pointing out the 
source of the error.

■■ Cell G4 contains the formula =Sheet5!A1. Excel displays the dashed arrow with the worksheet 
icon whenever the precedent or dependent exists on a different worksheet.

Error tracer (red) Tracer to another worksheet

Tracers (blue)

FIGURE 3-7  This worksheet demonstrates the three types of tracer arrows.

Tracing cell precedents
To trace cell precedents, follow these steps:

	 1.	 Select the cell that contains the formula whose precedents you want to trace.

	 2.	 Select Formulas > Trace Precedents. Excel adds a tracer arrow to each direct precedent.

	 3.	 Keep repeating step 2 to see more levels of precedents.
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Tip  You also can trace precedents by pressing Ctrl+], or by double-clicking the cell, pro-
vided that you turn off in-cell editing. You do this by choosing File > Options > Advanced 
and then deselecting the Allow Editing Directly In Cells check box. Now when you 
double-click a cell, Excel selects the formula’s precedents.

Tracing cell dependents
Here are the steps to follow to trace cell dependents:

	 1.	 Select the cell whose dependents you want to trace.

	 2.	 Select Formulas > Trace Dependents. Excel adds a tracer arrow to each direct dependent.

	 3.	 Keep repeating step 2 to see more levels of dependents.

 
Tip  You also can trace dependents by pressing Ctrl+[.

Tracing cell errors
To trace cell errors, follow these steps:

	 1.	 Select the cell that contains the error you want to trace.

	 2.	 Select Formulas > Error Checking > Trace Error. Excel adds a tracer arrow to each cell that 
produced the error.

Removing tracer arrows
To remove the tracer arrows, you have three choices:

■■ To remove all the tracer arrows, select Formulas > Remove Arrows.

■■ To remove precedent arrows one level at a time, select Formulas, open the Remove Arrows 
drop-down menu, and select Remove Precedent Arrows.

■■ To remove dependent arrows one level at a time, select Formulas, open the Remove Arrows 
drop-down menu, and select Remove Dependent Arrows.

Evaluating formulas
Earlier, you learned that you could troubleshoot a wonky formula by evaluating parts of it. You do this 
by selecting the part of the formula you want to evaluate and then selecting F9. This works fine, but it 
can be tedious in a long or complex formula, and there’s always a danger that you might accidentally 
confirm a partially evaluated formula and lose your work.
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A better solution is to use Excel’s Evaluate Formula feature. It does the same thing as the F9 tech-
nique, but it’s easier and safer. Here’s how it works:

	 1.	 Select the cell that contains the formula you want to evaluate.

	 2.	 Select Formulas > Evaluate Formula. Excel displays the Evaluate Formula dialog box.

	 3.	 The current term in the formula is underlined in the Evaluation box. At each step, you select 
from one or more of the following buttons:

•	 Evaluate: Display the current value of the underlined term.

•	 Step In: Display the first dependent of the underlined term. If that dependent also has a 
dependent, select this button again to see it (see Figure 3-8).

•	 Step Out: Hide a dependent and evaluate its precedent.

	 4.	 Repeat step 3 until you’ve completed your evaluation.

	 5.	 Select Close.

FIGURE 3-8  With the Evaluate Formula feature, you can “step into” the formula to display its dependent cells.

Watching cell values
In the precedent tracer example shown in Figure 3-7, the formula in cell G4 refers to a cell in another 
worksheet, which is represented in the trace by a worksheet icon. In other words, you can’t see the 
formula cell and the precedent cell simultaneously. This could also happen if the precedent existed on 
another workbook or even elsewhere on the same sheet if you’re working with a large model.

This is a problem because there’s no easy way to determine the current contents or value of the 
unseen precedent. If you’re having a problem, troubleshooting requires that you track down the far-off 
precedent to see if it might be the culprit. That’s bad enough with a single unseen cell, but what if your 
formula refers to 5 or 10 such cells? And what if those cells are scattered in different worksheets and 
workbooks?
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This level of hassle—not uncommon in the spreadsheet world—was undoubtedly the inspiration 
behind an elegant solution: the Watch Window. This window enables you to keep tabs on both the 
value and the formula in any cell in any worksheet in any open workbook. Here’s how you set up a 
watch:

	 1.	 Switch to the workbook that contains the cell or cells you want to watch.

	 2.	 Select Formulas > Watch Window. Excel displays the Watch Window.

	 3.	 Select Add Watch. Excel displays the Add Watch dialog box.

	 4.	 Either select the cell you want to watch or type in a reference formula for the cell (for example, 
=A1). Note that you can select a range to add multiple cells to the Watch Window.

	 5.	 Select Add. Excel adds the cell or cells to the Watch Window, as shown in Figure 3-9.

FIGURE 3-9  Use the Watch Window to keep an eye on the values and formulas of unseen cells that reside in other 
worksheets or workbooks.

When you no longer need a watch, you should remove it to avoid cluttering the Watch Window. To 
remove a watch, select Formulas > Watch Window to open the Watch Window, select the watch, 
and then select Delete Watch.
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Index

Symbols
#CALC! error, 52
#DIV/0! error, 52, 113
#FIELD! error, 53
#N/A error, 53
#NAME? error, 53–54
#NULL! error, 55
#NUM! error, 55
#REF! error, 56
#SPILL! error, 28, 56
#UNKNOWN error, 56
#VALUE! error, 56

A
absolute reference format, 14, 18
accounts payable ratios, 237

days purchases in accounts payable, 238
sales to accounts payable, 238
turnover, 237

accounts receivable ratios
accounts receivable turnover, 236
average AR duration, 236–237

acid-test ratio, 241
ADDRESS() function, 126–127
age of a person, calculating, 178
amortization schedule, building, 330–333
ampersand (&) operator, 7
Analysis TookPak, 78–79
AND() function, 116–117
ANSI codes, 83–84, 85
apostrophe (‘), converting formulas to text, 51
Apply Names dialog box, 19–20
applying, range names, 17–18

ignoring relative and absolute references, 18
using row and column names, 19–20

arguments, 73–74
ARRAYTOTEXT() function, 88
AVERAGE() function, 247
AVERAGEIF() function, 247

AVERAGEIFS() function, 248
BINOM.DIST() function, 271
BYCOL() function, 216
CEILING.MATH() function, 195
CELL() function, 130–131
CHAR() function, 83
CHOOSE() function, 141
CLEAN() function, 94
CONFIDENCE.NORM() function, 278
CONFIDENCE.T() function, 278
CORREL() function, 266
COUNT() function, 245
COUNTA() function, 245
COUNTBLANK() function, 246
COUNTIF() function, 246
COUNTIFS() function, 246
DATE() function, 166
DAY() function, 167
DAYS() function, 178
DAYS360() function, 180
DOLLAR() function, 89
EDATE() function, 171
EOMONTH() function, 171–172
EVEN() function, 196
FILTER() function, 389
FIND() function, 100
FIXED() function, 90
FLOOR.MATH() function, 195
FREQUENCY() function, 257
AND() function, 116
OR() function, 117
GETPIVOTDATA() function, 414
HOUR() function, 182
HYPGEOM.DIST() function, 272
IF() function, 112
IFS() function, 115
INDEX() function, 151
INFO() function, 134
INT() function, 196
IRR() function, 370

Z01_McFerdies_Index_p461-484.indd   461 21/01/22   6:01 PM



462

arguments

IS() function, 135
KURT() function, 277
LARGE() function, 251
LEFT() function, 97
LET() function, 210
LOWER() function, 86
MAP() function, 215
MATCH() function, 150
MAX() function, 250
MEDIAN() function, 248
MID() function, 98
MIN() function, 251
MINUTE() function, 183
MIRR() function, 372
MOD() function, 201
MONTH() function, 167
MROUND() function, 193
NETWORKDAYS() function,  

178–179
NORM.DIST() function, 275
NUMBERVALUE() function, 87
ODD() function, 196
PMT() function, 325
POISSON.DIST() function, 272
PROB() function, 269
PROPER() function, 87
RANDARRAY() function, 208
RANDBETWEEN() function, 207
REDUCE() function, 214
REPLACE() function, 104
REPT() function, 95
RIGHT() function, 98
ROUND() function, 193
ROUNDDOWN() function, 194
ROUNDUP() function, 194
SEARCH() function, 100
SECOND() function, 183
SEQUENCE() function, 208
SHEET() function, 134
SKEW() function, 276
SMALL() function, 251
SORT() function, 382
SORTBY() function, 383
STDEV.P() function, 256
STDEV.S() function, 256
SUBSTITUTE() function, 105
SUM() function, 198
SUMIF() function, 199
SUMIFS() function, 199–200

TEXT() function, 90
TEXTJOIN() function, 94
TIME() function, 182
TIMEVALUE() function, 182
TRIM() function, 93
TRUNC() function, 196
T.TEST() function, 280
UNIQUE() function, 389
VALUETOTEXT() function, 88
VLOOKUP() function, 145
WEEKDAY() function, 168
WEEKNUM() function, 168
WORKDAY.INTL() function, 170
XIRR() function, 371
XLOOKUP() function, 156
YEAR() function, 167
YEARFRAC() function, 180
Z.TEST() function, 279

arithmetic operators, 5–6
array formulas, 25–27

array constants, 30–31
braces ({ }), 27
combining with logical functions, 120

applying a condition across a range,  
120–121

counting occurrences in a range,  
124–125

determining where a value appears in a list, 
125–128

determining whether a value appears in a list, 
122–123

operating only on cells that meet a condition, 
121–122

dynamic, 26, 27–28, 32–33
functions, 31–32
INFO() function, 134
LAMBDA functions and, 214–215
processing, 29
that operate on multiple ranges,  

29–30
ARRAYTOTEXT() function, 88
auditing, 64–65

cell dependents, tracing, 66
cell precedents, tracing, 65–66
removing tracer arrows, 66

AutoComplete feature, 75–76
automatic calculation, 10
AVERAGE() function, 247
AVERAGEIF() function, 247–248
AVERAGEIFS() function, 248
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B
balloon loans, 326–327
best-fit trendlines, 283–285
billable time, rounding, 197
BINOM.DIST() function, 271
binomial distribution, 270–271
braces ({ }), 27
break-even point, calculating, 225–227
business modeling tools, 417

Goal Seek, 423–424
approximations, 427–428
break-even analysis, 428–429
generating a summary report, 435–437
optimizing product margin, 426–427
running, 424–425
scenarios, 430–435, 437
solving algebraic equations, 429–430

what-if analysis, 417–418
adding formulas to the input table, 420–421
editing a data table, 423
setting up a one-input data table, 418–420
setting up a two-input data table, 421–423

business models, 25
buttons, option, 46–47
BYCOL() function, 216–217
BYROW() function, 217–218

C
calculating. See also date(s); time(s)

averages, 247–249
best-fit values

using LINEST(), 288–290
using TREND(), 286–288

correlation, 266–267
covariance, 264–265
exponential trend, 308
extreme values, 250–252
future value

of a lump sum, 346–347
of a lump sum plus deposits, 348
of a series of deposits, 347

interest, 327, 328–329
interest rate, 335–336
internal rate of return

multiple internal rates of return,  
372–376

for nonperiodic cash flows, 371–372
using IRR(), 370–371

loan payments, 325
logarithmic trend, 312–313
net present value, 363–364
payback period, 367

discounted, 369–370
exact undiscounted payback point, 368–369
simple undiscounted, 367–368

percentile, 253–254
present value, 358, 359–360
principle, 328
probability, 267–270
rank, 253
standard deviation, 255–256
standard scores, 274
term of a loan, 333–335
variance, 254–255
weighted mean, 249–250

calculation
automatic, 10
manual, 10–11
multithreaded, 10–11
using rounding functions to prevent errors, 196–197

CEILING.MATH() function, 195
CELL() function, 130–132
cells. See also range names

absolute references, 14
data-validation rules, applying, 39–41
padding, 95–96
relative references, 13
tracing, 65–66

CHAR() function, 83
generating a series of letters, 84–85
generating the ANSI character set, 83–84

characters, removing from a string, 105–106
charts, text, 96–97
check boxes, 47
CHOOSE() function, 141

calculating weighted questionnaire results, 143
determining the month of the fiscal year, 142–143
determining the name of the day of the week, 141–142
integrating with worksheet option buttons, 143–144
looking up values ranges or tables, 144–145

circular reference formulas, 33–35, 59
CLEAN() function, 94, 106–107
CODE() function, 85–86
COLUMN() function, 103
combo boxes, 48–49
commands, Series, 84
comparison operators, 6
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compound interest, 343–344
concatenation, 7, 81, 94–95
conditional formatting, 118–120

applying a condition across a range, 120–121
determining whether a value appears in a list, 122–123
operating only on cells that meet a condition, 121–122

conditions, And, 116
confidence intervals, 277–278
CONFIDENCE.NORM() function, 278
CONFIDENCE.T() function, 278
consolidating multisheet data, 35–36

by category, 39–40
by position, 36–39

constants, array, 30–31
constraints, adding to Solver, 445–446
controlling

calculation
automatic, 10
manual, 10–11
multithreaded, 10–11

order of precedence, 8–10
controls, 43

adding to a worksheet, 44
check boxes, 47
combo boxes, 48–49
group boxes, 45–46
linking to a cell value, 45
list boxes, 48–49
option buttons, 46–47
scroll bars, 49
spin boxes, 49

converting
formulas

to text, 51
to a value, 16

between nominal rate and effective rate, 345–346
text, 86. See also text functions

to lowercase letters, 86
to numbers, 87
to proper case, 87
to sentence case, 98–99
to uppercase letters, 86–87

values to dates, 99–100
copying, formulas, 11–12, 16

absolute reference format, 14
relative reference format, 13
without adjusting relative references, 14–15

CORREL() function, 266–267
correlation, calculating, 266–267

cost of goods sold, calculating, 229–230
cost price, calculating, 223
COUNT() function, 245
COUNTA() function, 245
COUNTBLANK() function, 136, 246
COUNTIF() function, 246
COUNTIFS() function, 246
counting. See also statistical functions

number of errors in a range, 136
number of blanks in a range, 135–136

counting the number of blanks in a range
COUNTA(), 245
COUNTBLANK(), 246

covariance, calculating, 264–265
COVARIANCE.P() function, 265
COVARIANCE.S() function, 265
CUMIPMT, 329–330
CUMPRINC() function, 329–330
cumulative totals, calculating, 200–201

D
data validation, applying, 39–41
Data Validation dialog box, 42
DATE() function, 166
date functions, 164–165

DATE(), 166
DATEVALUE(), 166–167
DAY(), 167–168
DAYS(), 178
DAYS360(), 179–180
EDATE(), 171
EOMONTH(), 171–172
MONTH(), 167
NETWORKDAYS(), 178–179
TODAY(), 165–166
WEEKDAY(), 168
WEEKNUM(), 168
WORKDAY(), 169–170
WORKDAY.INTL(), 170
YEAR(), 167
YEARFRAC(), 180

date(s), 3, 99–100
adding X months to, 171
determining leap years, 202–203
difference between two, calculating, 177
Easter, calculating, 195
entering, 162–163
formats, 162–163
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formatting symbols, 91–92
holidays, calculating, 175–177
Julian, calculating, 177
nth occurrence of a weekday in a month, returning, 

172–175
serial numbers, 161–162
two-digit years, 163–164
X years, months, or days away from now, returning, 169

DATEVALUE() function, 166–167
DAY() function, 167–168
DAYS() function, 178
DAYS360() function, 179–180
dependent workbook, 21–22

changing the link source, 24
updating links, 23–24

deposits, calculating the future value of, 347
descriptive statistics, 243–244, 259–260. See also  

inferential statistics
Developer tab, 43

adding a control to a worksheet, 44
Form Controls list, 44

DGET() function, 396–397
dialog box. See also controls

Apply Names, 19–20
Data Validation, 42
Edit Links, 24
Evaluate Formula, 67
Function Arguments, 77

discount formulas, 223, 357
buying versus leasing, 361–362
discount amount, calculating, 224
discount rate, calculating, 224–225
discounting cash flows, 362–363
income investing versus purchasing a rental property, 

360–361
internal rate of return, calculating, 370

multiple internal rates of return, 372–376
for nonperiodic cash flows, 371–372
using IRR(), 370–371

list price, calculating, 225
net present value, calculating, 363–364

with nonperiodic cash flows, 366–367
using NPV(), 364–365
with varying cash flows, 365–366

net price, calculating, 223–224
payback period, calculating, 367

discounted, 369–370
exact undiscounted payback point, 368–369
simple undiscounted, 367–368

present value, calculating, 358, 359–360
taking inflation into account, 358–359

displaying, formulas, 15
using FORMULATEXT(), 15
using the menu, 15

DOLLAR() function, 89–90
drop-down lists, combining with exact-match lookups, 

149–150, 157–158
DSUM() function, 393–394
dynamic array formulas, 26, 27–28, 32–33

E
Easter dates, calculating, 195
EDATE() function, 171
Edit Links dialog box, 24
Edit mode, Excel, 5
editing

data tables, 423
formulas, 5
scenarios, 434

EFFECT() function, 345
effective interest, 344–345
Enter mode, Excel, 5
entering formulas, 4–5
EOMONTH() function, 171–172
error handling, 57

#CALC!, 52
#DIV/0!, 52, 113
#FIELD!, 53
#N/A, 53
#NAME?, 53–54
#NULL!, 55
#NUM!, 55
#REF!, 56
#SPILL!, 56
#UNKNOWN!, 56
#VALUE!, 56
auditing, 64–65

cell dependents, tracing, 66
cell precedents, tracing, 65–66
removing tracer arrows, 66

erroneous formula results, 58–59
IFERROR() function, 60
missing or mismatched parentheses, 57–58
#SPILL! error, 28
using the formula error checker, 60–61

choosing an error action, 61
options, 62–64

Z01_McFerdies_Index_p461-484.indd   465 21/01/22   6:01 PM



ERROR.TYPE() function

466

ERROR.TYPE() function, 132–133
Evaluate Formula dialog box, 67
evaluating, formulas, 66–67
EVEN() function, 196
exact-match lookups, 148–150, 157–158
Excel

Analysis ToolPak, 78–79
AutoComplete feature, 75–76
Edit mode, 5
Enter mode, 5
formulas, limits, 4
input modes, 5
Insert Function feature, 76–78
Point mode, 5

exponential trend, 305–306
calculating, 308
GROWTH() function, 308–309
LOGEST() function, 309–310
plotting, 306–307

exponentiation, 8
external references, 22–23
extreme values, calculating, 250–252

F
fill handle, extending linear trends, 293
FILTER() function, 389
filtering tables, 383

with the FILTER() function, 389
with the UNIQUE() function, 389
using complex criteria, 384–387
using computed criteria, 387–388

financial formulas
cost of goods sold, 229–230
fixed-asset ratios, 231

fixed assets to short-term debt, 232
fixed-asset turnover, 231
return on fixed assets, 232

gross margin, 230
net margin, 230–231
sales ratios, 228

sales per employee, 229
sales to current assets, 228
sales to short-term debt, 228–229

FIND() function
extracting a first or last name, 101–102
extracting first name, last name, and middle initial, 

102–103
FIXED() function, 90

fixed-asset ratios, 231
fixed assets to short-term debt, 232
fixed-asset turnover, 231
return on fixed assets, 232

FLOOR.MATH() function, 195
FORECAST() function, 297
forecasting, 281, 291

extending a linear trend
with the fill handle, 293
with the Series command, 293–294

with GROWTH(), 308–309
with LINEST(), 295–296
with the regression equation, 294–295
with TREND(), 295–296

formatting
conditional, 118–120
ledger shading, 203–204
text, 89. See also text functions

formulas, 3
absolute reference format, 14
arithmetic, 5–6
array, 25–27

array constants, 30–31
braces ({ }), 27
dynamic, 26, 27–28
functions, 31–33
processing, 29
that operate on multiple ranges, 29–30

calculation
automatic, 10
manual, 10–11
multithreaded, 10–11

circular reference, 33–35, 59
comparison, 6
conditional formatting, 118–120
converting

to text, 51
to a value, 16

copying, 11–12, 14-C01.-600
discount, 357

buying versus leasing, 361–362
discounting cash flows, 362–363
income investing versus purchasing a rental  

property, 360–361
internal rate of return, calculating, 370–376
net present value, calculating, 363–367
payback period, calculating, 367–370
present value, calculating, 358, 359–360
taking inflation into account, 358–359

Z01_McFerdies_Index_p461-484.indd   466 21/01/22   6:01 PM



functions

	 467

displaying, 15
using FORMULATEXT(), 15
using the menu, 15

editing, 5
entering, 4–5
error checker, 60–61

choosing an error action, 61
options, 62–64

evaluating, 66–67
financial

cost of goods sold, 229–230
fixed-asset ratios, 231–232
gross margin, 230
net margin, 230–231
sales ratios, 228–229

inventory
sales to inventory ratio, 234
turnover, 233
turnover rate, 233–234

inventory management, 234
inventory reorder level, 235
inventory safety stock, 234–235

iteration, 35
limits in Excel 365, 4
line breaks, 4
links, 21–22

changing the source, 24
external references, 22–23
updating, 23–24

liquidity, 236
accounts payable ratios, 237–238
accounts receivable ratios, 236–237
working capital, 239–240

liquidity index, 242
liquidity ratios

acid-test ratio, 241
cash ratio, 241
current ratio, 240

naming, 21
nesting, 4
operands, 3
operators, 3
order of precedence, 7–8

controlling, 8–9
parentheses and, 9–10

pricing, 221
break-even point, 225–227
discounts, 223–225
markups, 221–223

range names, 16, 17
reference, 7
referencing tables in, 389, 390–391
relative reference format, 13
structure, 3
table, 391–393
text, 7
updating, 16

FORMULATEXT() function, 9, 15
FREQUENCY() function, 256–258
Function Arguments dialog box, 77
functions, 71–72

ADDRESS(), 126–127
arguments, 73–74
arrays and, 31–32
COUNTBLANK(), 136
CUMIPMT, 329–330
CUMPRINC(), 329–330
date, 164–165

DATE(), 166
DATEVALUE(), 166–167
DAY(), 167–168
DAYS(), 178
DAYS360(), 179–180
EDATE(), 171
EOMONTH(), 171–172
MONTH(), 167
NETWORKDAYS(), 178–179
TODAY(), 165–166
WEEKDAY(), 168
WEEKNUM(), 168
WORKDAY(), 169–170
WORKDAY.INTL(), 170
YEAR(), 167
YEARFRAC(), 180

dynamic array, 32–33
EFFECT(), 345
FILTER(), 389
FORMULATEXT(), 9, 15
FV(), 73–74, 335, 346
GETPIVOTDATA(), 414–415
IF(), 47
IFERROR(), 60
INDEX(), 48–49
INDIRECT(), 329
information, 129–130

CELL(), 130–132
ERROR.TYPE(), 132–133
INFO(), 134
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IS(), 135–137
SHEET(), 134–135
SHEETS(), 134–135

IPPMT(), 328
IRR(), 370–371
LAMBDA, 212–214

BYCOL(), 216–217
BYROW(), 217–218
MAP(), 215–216
REDUCE(), 214–215

LET(), 209–211
logical, 109–110

AND(), 116–117
OR(), 117–118
combining with arrays, 120–125
IF(), 110–115
IFS(), 115

lookup, 139–140
CHOOSE(), 141–145
creating multiple-column lookups, 154–155
creating row-and-column lookups, 153–154
exact-match lookups, 148–150
HLOOKUP(), 146
INDEX(), 150–151
looking up a value using list boxes, 152
MATCH(), 150–151
returning a customer discount rate with a range 

lookup, 146–147
returning a tax rate with a range lookup, 147–148
using any column as the lookup column, 152–153
VLOOKUP(), 145
XLOOKUP(), 155–160

math, 189–192
CEILING.MATH(), 195
EVEN(), 196
FLOOR.MATH(), 195
INT(), 196–197
MOD(), 201–204
MROUND(), 193–194
ODD(), 196
RAND(), 205–207
RANDARRAY(), 207–208
RANDBETWEEN(), 207
ROUND(), 193
ROUNDDOWN(), 194
ROUNDUP(), 194
SEQUENCE(), 208–209
SUM(), 198–199
SUMIF(), 199

SUMIFS(), 199–200
TRUNC(), 196–197

MIRR(), 372–374
NA(), 53
NETWORKDAYS(), 128
NOMINAL(), 346
NPER(), 333–335, 349–350
NPV(), 364–365
PMT(), 325, 350
PPMT(), 328
PV(), 351
RATE(), 348–349, 352
SORT(), 382
SORTBY(), 383
statistical

AVERAGE(), 247
AVERAGEIF(), 247–248
AVERAGEIFS(), 248
BINOM.DIST(), 271
calculating the range, 254
CONFIDENCE.NORM(), 278
CONFIDENCE.T(), 278
CORREL(), 266–267
COUNT(), 245
COUNTA(), 245
COUNTBLANK(), 246
COUNTIF(), 246
COUNTIFS(), 246
COVARIANCE.P(), 265
COVARIANCE.S(), 265
FORECAST(), 297
FREQUENCY(), 256–258
GROWTH(), 308–309
HYPGEOM.DIST(), 272
KURT(), 276–277
LARGE(), 251–252
LINEST(), 288–290, 295–296
LOGEST(), 309–310
MAX(), 250–251
MEDIAN(), 248
MIN(), 250–251
MODE(), 249
NORM.DIST(), 274–275
OFFSET(), 261–264
PERCENTILE.EXC(), 253–254
PERCENTILE.INC(), 253–254
performing calculations on k values, 252
POISSON.DIST(), 272
PROB(), 269–270
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SKEW(), 276
SMALL(), 251–252
STDEV.P(), 255–256
STDEV.S(), 255–256
SUMPRODUCT(), 250
TREND(), 286–288, 295–296, 298–300, 321–322
T.TEST(), 280
Z.TEST(), 279

structure, 72–73
SUM(), 11–12, 200–201
syntax, 73
table, 393–395

DAVERAGE(), 395
DGET(), 396–397
DSUM(), 393–394

text, 81
ARRAYTOTEXT(), 88
CHAR(), 83–85
CLEAN(), 94, 106–107
CODE(), 85–86
DOLLAR(), 89–90
FIND(), 100–103
FIXED(), 90
LEFT(), 97
LOWER(), 86, 98–99
MID(), 98
NUMBERVALUE(), 87
PROPER(), 87
REPLACE(), 104
REPT(), 95–97
RIGHT(), 98
SEARCH(), 100–103
SUBSTITUTE(), 105
TEXT(), 90–92
TEXTJOIN(), 94–95
TRIM(), 93
UPPER(), 86–87, 98–99
VALUETOTEXT(), 88–89

time, 181
HOUR(), 182–183
MINUTE(), 183
NOW(), 181
SECOND(), 183
TIME(), 182
TIMEVALUE(), 182

trigonometric, 192
typing into a formula, 75–76
UNIQUE(), 389
WEEKDAY(), 127

XIRR(), 371–372
XNPV(), 366–367

FV() function, 73–74, 335, 346

G
GETPIVOTDATA() function, 414–415
GIGO (garbage in, garbage out), 41
Goal Seek, 423–424

approximations, 427–428
break-even analysis, 428–429
generating a summary report, 435–437
optimizing product margin, 426–427
running, 424–425
scenarios, 430–432

adding, 432–433
deleting, 437
displaying, 433–434
editing, 434
merging, 435
setting up your worksheet for, 432

solving algebraic equations, 429–430
gross margin, calculating, 230
group boxes, 45–46
GROWTH() function, 308–309

H
hiding

PivotTable grand totals, 400
PivotTable subtotals, 400

HLOOKUP() function, 146
holidays, calculating, 175–177
HOUR() function, 182–183
hypergeometric distribution, 271–272
HYPGEOM.DIST() function, 272
hypothesis testing, 278–280

I
IF() function, 47, 110–112

avoiding division by zero, 113
calculating tiered bonuses, 114–136
handling a FALSE result, 112–113
nesting, 114
performing multiple logical tests, 113

IFERROR() function, 60
IFS() function, 115
INDEX() function, 48–49, 150–151
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INDIRECT() function, 329
inferential statistics

confidence intervals, 277–278
hypothesis testing, 278–280
measures of association, 264

correlation, 266–267
covariance, 264–265

normal distribution, 272–273
kurtosis, 276–277
normal percentiles, calculating, 274–275
skewness, 275–276
standard scores, calculating, 274

probability, 267
binomial distribution, 270–271
calculating, 267–270
hypergeometric distribution, 271–272
Poisson distribution, 272

sampling data, 260–261
extracting a periodic sample, 261–263
extracting a random sample, 263–264

inflation rate, 358–359
INFO() function, 134
information functions, 129–130

CELL(), 130–132
ERROR.TYPE(), 132–133
INFO(), 134
IS(), 135

checking a range for non-numeric values, 136
counting the number of blanks in a range, 135–136
counting the number of errors in a range, 136
ignoring errors when working with a range, 137

SHEET(), 134–135
SHEETS(), 134–135

input modes, Excel, 5
Insert Function feature, 76–78
INT() function, 196–197
intelligence, 109
interest

calculating, 327, 328–329
rates, 343

compound interest, 343–344
converting between nominal rate and effective 

rate, 345–346
effective interest, 344–345
nominal interest, 344–345

internal rate of return, calculating
multiple internal rates of return, 372–376
for nonperiodic cash flows, 371–372
using IRR(), 370–371

inventory formulas
inventory turnover, 233
inventory turnover rate, 233–234
sales to inventory ratio, 234

inventory management formulas, 234
inventory reorder level, 235
inventory safety stock, 234–235

investment formulas, 343
calculating the future value, 346

of a lump sum, 346–347
of a lump sum plus deposits, 348
of a series of deposits, 347

interest rates, 343
compound interest, 343–344
converting between nominal rate and effective 

rate, 345–346
effective interest, 344–345
nominal interest, 344–345

working toward an investment goal, 348
calculating the future value with varying interest 

rates, 351–352
calculating the required initial deposit, 351
calculating the required interest rate,  

348–349
calculating the required number of periods, 

349–350
calculating the required regular deposit, 350

IPPMT() function, 328
IRR() function, 370–371
IS() function, 135

checking a range for non-numeric values, 136
counting the number of blanks in a range, 135–136
ignoring errors when working with a range, 137

iteration, 35

J-K
Julian date, calculating, 177
KURT() function, 276–277
kurtosis, 276–277

L
LAMBDA functions, 212–214

BYCOL(), 216–217
BYROW(), 217–218
MAP(), 215–216
REDUCE(), 214–215

LARGE() function, 251–252
ledger shading, 203–204
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lump sum, calculating future value of

LEFT() function, 97
LET() function, 209–211
line breaks, 4
line feeds, removing, 106–107
linear trends, extending

with the fill handle, 293
with the Series command, 293–294

LINEST() function, 295–296
links, 21–22

changing the source, 24
external references, 22–23
updating, 23–24

liquidity formulas, 236
accounts payable ratios, 237

days purchases in accounts payable, 238
sales to accounts payable, 238
turnover, 237

accounts receivable ratios
accounts receivable turnover, 236
average AR duration, 236–237

working capital, 239–240
liquidity index formula, 242
liquidity ratio formulas

acid-test ratio, 241
cash ratio, 241
current ratio, 240

list boxes, 48–49, 152
list price, calculating, 225
lists, finding values in, 125–128
loading, Solver, 441
loans

amortization schedule, building, 330–333
balloon, 326–327
calculating how much you can borrow, 337–340
calculating the term of, 333–335
cumulative principle, calculating, 329–330
interest costs, calculating, 327, 328–329
interest rate, calculating, 335–336
payments

analysis, 325–326
calculating, 325

principle, calculating, 328
logarithmic trend, 310–311

calculating logarithmic trend and forecast values, 
312–313

plotting a trendline, 311–312
logical functions, 109–110

AND(), 116–117
OR(), 117–118

combining with arrays, 120
applying a condition across a range, 120–121
counting occurrences in a range, 124–125
determining where a value appears in a list, 

125–128
determining whether a value appears in a list, 

122–123
operating only on cells that meet a condition, 

121–122
conditional formatting, 118–120
IF(), 110–112

avoiding division by zero, 113
calculating tiered bonuses, 114–136
handling a FALSE result, 112–113
nesting, 114
performing multiple logical tests, 113

IFS(), 115
lookup functions, 139–140

CHOOSE(), 141
calculating weighted questionnaire results, 143
determining the month of the fiscal year,  

142–143
determining the name of the day of the week, 

141–142
integrating with worksheet option buttons, 

143–144
looking up values ranges or tables, 144–145

creating multiple-column lookups, 154–155
creating row-and-column lookups, 153–154
exact-match lookups, 148–150
HLOOKUP(), 146
INDEX(), 150–151
looking up a value using list boxes, 152
MATCH(), 150–151
returning a customer discount rate with a range 

lookup, 146–147
returning a tax rate with a range lookup,  

147–148
using any column as the lookup column, 152–153
VLOOKUP(), 145
XLOOKUP(), 155–157

combining exact-match lookups with in-cell  
drop-down lists, 157–158

creating multiple-column lookups,  
159–160

looking up a customer account, 157
using any column as the lookup column, 159

lookup tables, 140–141
LOWER() function, 86, 98–99
lump sum, calculating future value of, 346–347
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manipulating, text

M
manipulating, text, 93–94
manual calculation, 10–11
MAP() function, 215–216
markups, 221

amount, calculating, 222
cost price, calculating, 223
selling price, 222

MATCH() function, 150–151
math functions, 189–192

CEILING.MATH(), 195
EVEN(), 196
FLOOR.MATH(), 195
INT(), 196–197
MOD(), 201–204
MROUND(), 193–194
ODD(), 196
RAND(), 205–207
RANDARRAY(), 207–208
RANDBETWEEN(), 207
ROUND(), 193
ROUNDDOWN(), 194
ROUNDUP(), 194
SEQUENCE(), 208–209
SUM(), 198–199, 200–201
SUMIF(), 199
SUMIFS(), 199–200
TRUNC(), 196–197

MAX() function, 250–251
measures of association, 264

correlation, 266–267
covariance, 264–265

MEDIAN() function, 248
messages, Solver, 452–456
MID() function, 98
MIN() function, 250–251
MINUTE() function, 183
MIRR() function, 372–374
MOD() function, 201–204
MODE() function, 249
MONTH() function, 167
MROUND() function, 193–194
multiple regression, 320–322
multisheet data, consolidating,  

35–36
by category, 39–40
by position, 36–39

multithreaded calculation, 10–11

N
NA() function, 53
names

#NAME? error and, 53–54
formula, 21
range, 16

applying, 17–18, 19–20
pasting, 17

nesting, 4, 114
net margin, calculating, 230–231
net present value, calculating, 363–364

with nonperiodic cash flows, 366–367
using NPV(), 364–365
with varying cash flows, 365–366

net price, calculating, 223–224
NETWORKDAYS() function, 128, 178–179
NOMINAL() function, 346
nominal interest, 344–345
normal distribution, 272–273

kurtosis, 276–277
normal percentiles, calculating, 274–275
skewness, 275–276
standard scores, calculating, 274

NORM.DIST() function, 274–275
NOW() function, 181
NPER() function, 333–335
NPV() function, 364–365
NUMBERVALUE() function, 87

O
ODD() function, 196
OFFSET() function, 261–264
operands, 3
operators, 3

arithmetic, 5–6
comparison, 6
order of precedence, 7–9
reference, 7

option buttons, 46–47
order of precedence, 7–8

controlling, 8–9
parentheses and, 9–10

OR() function, 117–118

P
padding a cell, 95–96
parentheses

Z01_McFerdies_Index_p461-484.indd   472 21/01/22   6:01 PM



regression

	 473

controlling order of precedence, 9–10
missing or mismatched, troubleshooting, 57–58

pasting, range names, 17
payback period, calculating, 367

discounted, 369–370
exact undiscounted payback point, 368–369
simple undiscounted, 367–368

PERCENTILE.EXC() function, 253–254
PERCENTILE.INC() function, 253–254
PivotTable

calculated fields, inserting, 411–412
calculated items, inserting, 412–414
creating custom calculations, 409–411
grand totals, hiding, 400
subtotals, 399–400

customizing, 401
hiding, 400

summary calculation
changing the value field, 401–402
difference, 402–404
index, 408–409
percentage, 404–406
running total, 406–407

using results in a worksheet formula, 414–415
PMT() function, 325, 350
Point mode, Excel, 5
Poisson distribution, 272
POISSON.DIST() function, 272
polynomial regression, 282, 316–317

calculating polynomial trend and forecast values, 
318–319

plotting a trendline, 317
power trend, 313–314

calculating power trend and forecast values,  
315–316

plotting a trendline, 314–315
PPMT() function, 328
present value, calculating, 358, 359–360
price points, setting, 197
pricing formulas, 221

break-even point
calculating, 225–227

discounts, 223
discount amount, 224
discount rate, calculating, 224–225
list price, 225
net price, 223–224

markups, 221
amount, calculating, 222

cost price, calculating, 223
selling price, 222

principle, calculating, 328
PROB() function, 269–270
probability, 267

binomial distribution, 270–271
calculating, 267–270
confidence intervals, 277–278
hypergeometric distribution, 271–272
Poisson distribution, 272

PROPER() function, 87
properties, CORREL() function, 266
PV() function, 351

R
RAND() function, 205–207
RANDARRAY() function, 207–208
RANDBETWEEN() function, 207
random character generation

letters, 206
n-digit numbers, 205–206

range(s), 29–30. See also array formulas
#NAME? errors, 54–55
calculating, 254
conditional formatting, 120–121
counting occurrences in, 124–125
counting the number of blanks in, 135–136
counting the number of errors in, 136
ignoring errors when working with, 137
lookups, 144–145, 146–148
names, 16, 17

applying, 17–18
ignoring relative and absolute references, 18
using row and column names, 19–20

rank, calculating, 253
RATE() function, 348–349, 352
REDUCE() function, 214–215
reference operators, 7
references

#REF! errors, 56
absolute, 14
circular, 33–35
relative, 13

regression, 281–282
choosing a method, 282
multiple, 320–322
polynomial. See polynomial regression,  

316–317
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regression

calculating polynomial trend and forecast values, 
318–319

plotting a trendline, 317
simple. See simple regression

relative reference format, 13, 18
removing

line feeds, 106–107
tracer arrows, 66
unwanted characters from a string, 93–94, 106
watches, 68

repeating, strings, 95–97
REPLACE() function, 104
reports

Goal Seek, 435–437
Solver, 456

Answer, 456–457
Limits, 459–460
Sensitivity, 458–459

REPT() function, 95
building text charts, 96–97
padding a cell, 95–96

return on fixed assets, calculating, 232
RIGHT() function, 98
ROUND() function, 193
ROUNDDOWN() function, 194
ROUNDUP() function, 194

S
sales per employee, calculating, 229
sales ratios, 228

sales per employee, calculating, 229
sales to current assets, calculating, 228
sales to short-term debt, calculating, 228–229

sampling data, 260–261
extracting a periodic sample, 261–263
extracting a random sample, 263–264

scroll bars, 49
SEARCH() function

extracting a first or last name, 101–102
extracting first name, last name, and middle initial, 

102–103
SECOND() function, 183
selling price, calculating, 222
SEQUENCE() function, 208–209
serial numbers, date and time, 161–162
Series command, 84, 293–294
SHEET() function, 134–135
SHEETS() function, 134–135

simple regression, 282
best-fit trendlines, 283–285
calculating best-fit values

using LINEST(), 288–290
using TREND(), 286–288

forecasting, 291
extending a linear trend, 293–294
with LINEST(), 295–296
plotting forecasted values, 292
with the regression equation, 294–295
with TREND(), 295–296

logarithmic trend, 310–311
calculating logarithmic trend and forecast values, 

312–313
plotting a trendline, 311–312

on nonlinear data, 305–310
power trend, 313–314

calculating power trend and forecast values, 
315–316

plotting a trendline, 314–315
R2, 286
trend analysis, 290–291
understanding the regression equation, 285–286

SKEW() function, 276
skewness, 275–276
SMALL() function, 251–252
Solver, 439–440, 442–444

adding constraints, 445–446
advantages of, 440
loading, 441
messages, 452–456
models, 451–452
options, 447, 448–451
reports, 456

Answer, 456–457
Limits, 459–460
Sensitivity, 458–459

saving a solution as a scenario, 446–447
selecting a solving method, 447–448
when to use, 440–441

SORT() function, 382
SORTBY() function, 383
sorting

tables, 379–380
on a part of a field, 380–381
without articles, 381–382

values randomly, 206–207
spin boxes, 49
standard deviation, calculating, 255–256
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text

standard scores, calculating, 274
statistical functions. See also descriptive statistics;  

inferential statistics; regression
AVERAGE(), 247
AVERAGEIF(), 247–248
AVERAGEIFS(), 248
BINOM.DIST(), 271
calculating the range, 254
CONFIDENCE.NORM(), 278
CONFIDENCE.T(), 278
CORREL(), 266–267
COUNT(), 245
COUNTIF(), 246
COUNTIFS(), 246
COVARIANCE.P(), 265
COVARIANCE.S(), 265
FORECAST(), 297
FREQUENCY(), 256–258
GROWTH(), 308–309
HYPGEOM.DIST(), 272
KURT(), 276–277
LARGE(), 251–252
LINEST(), 288–290, 295–296
LOGEST(), 309–310
MAX(), 250–251
MEDIAN(), 248
MIN(), 250–251
MODE(), 249
NORM.DIST(), 274–275
OFFSET(), 261–264
PERCENTILE.EXC(), 253–254
PERCENTILE.INC(), 253–254
performing calculations on k values, 252
POISSON.DIST(), 272
PROB(), 269–270
rank, calculating, 253
SKEW(), 276
SMALL(), 251–252
STDEV.P(), 255–256
STDEV.S(), 255–256
SUMPRODUCT(), 250
TREND(), 286–288, 295–296, 298–300, 321–322
T.TEST(), 280
Z.TEST(), 279

STDEV.P() function, 255–256
STDEV.S() function, 255–256
strings, 81

concatenation, 7
extracting a substring, 97–98

removing characters from, 105
removing unwanted characters, 93–94
removing unwanted characters from, 93–94
repeating, 95–97

SUBSTITUTE() function, 105
substrings

extracting, 97–98
searching for, 100–103
substituting one for another, 104–105

SUM() function, 11–12, 198–199, 200–201
SUMIF() function, 199
SUMIFS() function, 199–200
summing

every nth row, 202
time values, 184
values, 198–200

SUMPRODUCT() function, 250
symbols

date and time formatting, 91–92
numeric formatting, 91

T
table(s), 379. See also PivotTable

filtering, 383
with the FILTER() function, 389
with the UNIQUE() function, 389
using complex criteria, 384–387
using computed criteria, 387–388

formulas, 391–393
functions, 393–395

DAVERAGE(), 395
DGET(), 396–397
DSUM(), 393–394

looking up values in, 144–145
referencing in formulas, 389, 390–391
sorting, 379–380

into an array, 382–383
on a part of a field, 380–381
without articles, 381–382

text
converting

to lowercase letters, 86
to numbers, 87
to proper case, 87
to sentence case, 98–99
to uppercase letters, 86–87

formatting, 89
manipulating, 93–94

Z01_McFerdies_Index_p461-484.indd   475 21/01/22   6:01 PM



text formulas

476

text formulas, 7
TEXT() function, 90–91

date and time formatting symbols, 91–92
displaying when a workbook was last updated, 92
numeric formatting symbols, 91

text functions, 81
ARRAYTOTEXT(), 88
CHAR(), 83

generating a series of letters, 84–85
generating the ANSI character set, 83–84

CLEAN(), 94
CODE(), 85–86
DOLLAR(), 89–90
FIND()

extracting a first or last name, 101–102
extracting first name, last name, and middle 

initial, 102–103
FIXED(), 90
LEFT(), 97
LOWER(), 86, 98–99
MID(), 98
NUMBERVALUE(), 87
PROPER(), 87
REPLACE(), 104
REPT(), 95

building text charts, 96–97
padding a cell, 95–96

RIGHT(), 98
SEARCH()

extracting a first or last name, 101–102
extracting first name, last name, and middle 

initial, 102–103
SUBSTITUTE(), 105
TEXT(), 90–91

date and time formatting symbols, 91–92
displaying when a workbook was last updated, 92
numeric formatting symbols, 91

TEXTJOIN(), 94–95
TRIM(), 93
UPPER(), 86–87, 98–99
VALUETOTEXT(), 88–89

TEXTJOIN() function, 94–95
TIME() function, 182
time functions, 181

HOUR(), 182–183
MINUTE(), 183
NOW(), 181
SECOND(), 183
TIME(), 182

TIMEVALUE(), 182
time(s)

calculating the difference between two, 184–187
entering, 162–163
formats, 162–163
formatting symbols, 91–92
serial numbers, 161–162
summing values, 184
value of money, 323–324, 343, 357
X hours, minutes, or seconds from now, returning, 

183–184
TIMEVALUE() function, 182
TODAY() function, 165–166
tracing

cell dependents, 66
cell errors, 66
cell precedents, 65–66
removing tracer arrows, 66

TREND() function, 286–288, 295–296, 298–300, 321–322
trigonometric functions, 192
TRIM() function, 93
troubleshooting. See also error handling

auditing, 64–65
cell dependents, tracing, 66
cell precedents, tracing, 65–66
removing tracer arrows, 66

circular references, 59
erroneous formula results, 58–59
missing or mismatched parentheses, 57–58
using the formula error checker, 60–61

choosing an error action, 61
options, 62–64

TRUNC() function, 196–197
T.TEST() function, 280
two-digit years, 163–164

U
UNICODE, 83, 85
UNIQUE() function, 389
updating

formulas, 16
links, 23–24

UPPER() function, 86–87, 98–99

V
value(s)

ANSI, 83, 85
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converting formulas to, 16
converting to dates, 99–100
converting to text, 88–89
extreme, calculating, 250–252
finding in a list, 125–128
looking up in ranges or tables, 144–145
present, 358
slotting into categories, 116–117
sorting randomly, 206–207
summing, 198–200
time, summing, 184
UNICODE, 83, 85
watching, 67–68

VALUETOTEXT() function, 88–89
variables, 260, 281–282. See also measures of association
variance, calculating, 254–255
VBA (Visual Basic for Applications), toggling PivotTable 

difference calculation, 403–404
VLOOKUP() function, 145

W
watches

removing, 68
setting up, 68

WEEKDAY() function, 127, 168
WEEKNUM() function, 168
weighted mean, calculating, 249–250
what-if analysis, 417–418

adding formulas to the input table, 420–421
editing a data table, 423
setting up a one-input data table, 418–420
setting up a two-input data table, 421–423

workbooks

dependent, 21–22
displaying when last updated, 92

WORKDAY() function, 169–170
WORKDAY.INTL() function, 170
working capital, 239

turnover, 239–240
worksheet(s)

auditing, 64
calculation

automatic, 10
manual, 10–11
multithreaded, 10–11

consolidating multisheet data, 35–36
by category, 39–40
by position, 36–39

controls, adding, 44
using PivotTable results in, 414–415

X
XIRR() function, 371–372
XLOOKUP() function

combining exact-match lookups with in-cell  
drop-down lists, 157–158

creating multiple-column lookups, 159–160
looking up a customer account, 157
using any column as the lookup column, 159

XNPV() function, 366–367

Y-Z
YEAR() function, 167
YEARFRAC() function, 180
Z.TEST() function, 279
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